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Within this book, you will learn the necessary skills to create professional live streaming events, podcasts, and 
video content. Each section will provide a guide to understanding each of these open source technologies and 
methods of using them. While this book has a focus on digital communication and learning objects, there is no 
single way to create any of these media types. This book will provide you with techniques and features that are 
useful in the development of both digital communication and the development of learning objects. 

This book provides foundational techniques for using each of these tools and a final section on methods of 
collaborating with others while using these tools. These tools can be applied in numerous ways and are very 
dynamic and continually changing, because they are open source projects. If any of the material within this 
book becomes dated, please contact the authors. 

The intention of this book is to help you become comfortable using media technology. Each of these tools has 
foundational functionality that can be found in proprietary software. When you have completed the exercises 
within this book, you will find the use of other media editing tools less intimidating, because you will be well 
versed in the language of each media type. 

As previously stated there is no single way to use creative technology like digital media software and the 
power of these tools is associated with your own creative prowess. 
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PART I 

OBS STUDIO 

Open Broadcast Software Studio (OBS Studio) is a popular open-source streaming software. It gained most of 
its notoriety with the rise of the video game streaming platform Twitch. It is currently used by these streamers 
to synchronously display their videogame play, a camera of themselves playing, and generate graphic overlays, 
while conversing with viewers through chat functions. This book was based on the curiosity to explore how 
these functions, which are used simultaneously to create highly engaging content, could be used to enhance 
synchronous online instruction. 

This book will will assist you with using OBS and virtual cameras to be used as your camera within Zoom to 
use the software during meetings, workshops, or general instruction. This book will show you how to stage your 
Scenes and Sources in your Preview and Transition them to your Program and go over all the features of the 
software. Additionally, we will have some fun with this. This section will go over understanding OBS’ software 
interface, creating tickers and banners for important information, how to use OBS Studio to record your desktop 
for instructional videos, and how you can use the software to provide a more dynamic synchronous and 
asynchronous instructional experience. 

Overall Lesson Objectives 

• To help faculty, librarians and researchers improve synchronous and asynchronous virtual instruction 
• To understand how to use Open Broadcast Software 
• Make virtual learning more interesting for students 

Learning Outcomes 

• Methods of Using OBS for Synchronous 
• Methods of Using OBS for Asynchronous 
• How to use OBS to record your Screen for training or instruction 

Install OBS Studio 

1. This software can be downloaded for Windows, Mac, or Linux: Download OBS Studio 
2. Also, verify your computer meets the System Requirements of the Software 
3. Please, have the software installed so you can participate in this build-a-long style workshop. 

When you initiate your first profile in OBS immediately after opening the application, select to “Optimize just 
for recording, I will not be streaming” option. 
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This is simply because it is the simplest setup option and all the skills presented within this section will be 
applicable to each use of the application. The final chapter within this section will go over how to set up a Live 
Streaming profile. 
Please note, this guide was written using OBS Studio Version 27.1.3. Due to the open source nature of OBS 
Studio and the updates made to the software over time, the version you work with may differ slightly from 
what is presented here. 
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1. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=20#oembed-1 

Drag and drop the labels to the appropriate areas on the OBS Studio Interface: 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=20 
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2. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=31#oembed-1 

To add a Video Capture Device to your Scene: 
1. Click the “+” at the bottom of the Sources dock & select Video Capture Device. Give the source a name. 

2. If you have more than one camera attached to your computer, you can select which device you would like to 
use. Click “OK” 
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3. In the same Scene, add a Text Source. To do this, click the “+” at the bottom of the Sources dock 
4. Select Text (GDI+) (on a Mac, this will be labelled Text (FreeType 2)). Give your Text Source a name. 

6. Add some text in the ‘Text’ field, followed by 20 empty spaces 
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7. Set the background opacity to 50%. You can also adjust the font, alignment, and other settings if desired. 

For now, ignore Chatlog Mode (this is for streaming only) 

8. Ensure your Ticker appears above your Camera in the Sources box. If it is listed below, simply click and drag it 
until it appears above. 

9. Select your Text source and click “Filters” just above the Sources Dock

 
10. Now, let’s apply the Scroll filter to the text source we just created. Click the “+” at the bottom of the Effect 

Filters window and select “Scroll.” 
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11. Change the “Horizontal Speed” to 200 

You should now notice that you text is scrolling across your Scene – you have now made a ticker in OBS! 😊 Next, 
you’ll learn how to display your new camera and ticker in a Zoom meeting. 
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3. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=39#oembed-1 

Now that you’ve created a Scene in OBS, we can click “Start Virtual Camera” in the Controls Dock to initiate its 
use in Zoom 

Then in your Zoom click the “^” carrot and select “OBS Virtual Camera” 

You could also select “Video Settings” and the select your “OBS Virtual Camera” in that menu 
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You might not notice anything has happened yet, and that could be because you need to Transition the content 
from your Preview window to your Program window. You can do this by selecting the Transition button, which 
is positioned between the Preview and the Program windows. 
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You might also notice people are indicating your text is backwards. In the Zoom video settings, you can flip how 
your camera is displaying by selecting the ‘Mirror my video’ under ‘My Video’ 
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4. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=47#oembed-1 

Creating a headline banner is an effective way to add a sense of professional to your content, whether it’s for a 
workshop or a classroom. To accomplish this: 

1. In the Source dock, click the + button and create a ‘Color Source’ 
2. At first, the Color Source will be covering the entire Program window. To fix this, hold the Shift key and 

drag the top middle handle of the Color Source down to the lower part of your Preview window.

3. Bring the Color Source to the top of the Sources list, if it is not yet there. You can either drag and drop the 
Color Source to the top of the list, or right click, select Order, and Move to Top
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4. Select the Color Source 

5. Click on Filters above the Sources Dock
6. In the FIiters Window, click the “+” to create a new Filter 
7. Select the Color Correction Filter
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8. Change the Opacity to 50 
9. Click Close to exit the Filters Window 

You will now notice your Color Source is slightly transparent. 
Click this link and download the UTSC Library logo 

1. Right click on the logo and click Save Image As 
2. Save to a location you can access easily
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Back in OBS Studio: 

1. Create a new Image Source by clicking on the “+” in the Sources Dock 
2. Click Browse, and select the UTSC Library logo we just saved 
3. Position the logo on top of the Color Source

If you would like to, you can add a Text Source with your name and title. 
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5. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=52#oembed-1 

Using the Display Capture is probably one of the most useful methods of using OBS for instruction. There are 
both merits to using it for asynchronous and synchronous instructional content creation and delivery. 

To add a Display Capture to your Scene: 

1. Click the “+” at the bottom of the Sources dock 
2. Select Display Capture from the Sources menu 
3. Give a name to this Source 
4. Select the display you would like to capture, if you have more than one display available. Also, choose 

whether you would like your cursor to be visible or not. Click “OK” 

Recording 
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You can begin recording your screen capture by selecting “Start Recording” in the Controls Dock 

To locate your recording, go to File > Show Recordings 

18  |  Using Display Capture as a Source &#038; Recording



6. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=61#oembed-1 

Let’s say you’re conducting a lesson or workshop and you want to watch a video with your students or 
participants. You can accomplish this using either the Browser Capture or Window Capture option – both of 
which have pros and cons. 

Browser Capture 
1. Create a new Scene 
2. In the Sources dock, click the + button and make a new Browser Capture source 
3. Add the URL you’d like the Browser Capture to use, then click OK 

4. One of the biggest pros of using Browser Captures is that by selecting the ‘Interact’ button, you’ll be able to 
interact with the browser from within OBS as you would a normal browser, without having to exit OBS 
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5. One issue is that you will not be able to scroll within the Browser Capture source. To fix this, open the 
Browser Capture properties and edit the Custom CSS by removing “hidden;” from the end of the line 

 
Window Capture 
1. In the Sources dock, click the + button and make a new Window Capture source 
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2. Select the window you’d like to capture 

3. One pro to using Window Capture is that, unlike Browser Capture, you’ll be able to quickly swap to a different 
window that you have open on your computer. To do this, select the Window dropdown menu and choose a 
different window 

Another positive is that if you have multiple tabs open in an internet browser, you will be able to quickly swap 
between them. However, unlike a Browser Source, you will need to exit OBS to interact with the browser, instead 
of interacting with it directly within OBS. 
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7. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=67#oembed-1 

Automatic Scene Switcher is a feature that functions so that, rather than manually switching between scenes, 
OBS will switch between them for you when you swap between programs on your computer. This can make 
creating content easier and feel more natural, whether synchronous or asynchronous. 

1. Create a new Scene called Scene 1 and add a Window Capture source 
2. Create a second Scene called Scene 2 and another Window Capture source within this second Scene 
3. Click Tools, then select Automatic Scene Switcher 

4. From the dropdown menu, select your first source, as well as the Scene it’s located in 
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5. Click the + button to add the selected Scene to the Scene Switcher 
6. Repeat steps 4-5, but this time selecting the source and Scene created in step 2 
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Now, rather than continually switching between scenes and sources manually, when you click on that file or 
program on your computer, OBS will automatically swap between your Scenes. You can also make it so that 
when you click away from these files or programs altogether, OBS automatically switches back to a main or 
default screen. 

1. Create a new Scene called Scene 3 and add your camera as a Video Capture Device 
2. Open the Automatic Scene Switcher 
3. Select “When no window matches, switch to Scene 3” 
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After setting this up, when you click away from the programs or files or click into a new window that has not 
been added as part of the automatic scene switcher, OBS will by default switch back to your camera. Now you 
can interact with your files and programs as you normally would, and OBS will take care of the Scene switching 
in the background! 

 
 

Automatic Scene Switcher  |  25



8. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=74#oembed-1 

An exceptional and free tool to use with OBS Studio is OBS Ninja. Using OBS Ninja, you can add additional 
participants’ cameras to something like a meeting, workshop, or class, and even share their screen through 
OBS. This can be accomplished using a computer or mobile phone. 

1. Open OBS Ninja 
2. Click ‘Add Your Camera to OBS’ and press the green Start button 

3. Adjust settings such as which camera is in use, audio source, and video effects if desired 
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4. Copy the green link at the top of the screen 

5. Open OBS and create a Browser source 
6. Paste the OBS Ninja URL in the Browser URL field 
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You should now have the OBS Ninja source visible in your Preview/Program window! 

 
This can be a really powerful tool for creating, for example, a panel discussion. To do this, the panel guest 

would be the person navigating to OBS Ninja and generating the link (steps 1-4). They would then share the link 
with the panel leader, who would then add it into OBS (steps 5-6). 

To avoid any audio issues like echo, you might suggest your participant use headphones. It’s strongly 
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recommended that you allow you and your participant to set this up 15-30 minutes prior to the event to iron out 
any technical issues. 

 

Creating Panel Discussions with OBS Ninja  |  29



9. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=83#oembed-1 

Using our knowledge of OBS Ninja, we’ll learn how to remotely share someone else’s screen. For this exercise, 
use the same Scene you used in the previous chapter. 

1. Open OBS Ninja 
2. Click ‘Remote Screen Share Into OBS.’ 

3. Click the gear icon and change the video quality settings to account for slower internet speeds if necessary. 

4. Click the blue ‘Select Screen to Share’ button and select a screen/window/browser. Select whether or not to 
include audio. 
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5. Copy the green OBS Ninja link at the top of the screen 

6. Open OBS and create a Browser source & paste the OBS Ninja URL in the Browser URL field 

Adding a Remote Screen Share  |  31



 
Now your guest speaker can, for example, show and refer to slides or images during the panel discussion! 
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10. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=93#oembed-1 

Adding captions to a live stream or video is an effective way to enhance your content’s accessibility. You can do 
this by using Google Slides. In this exercise, we’ll use the Scene from the previous Panel Discussion chapters. 

1. In Google Slides, create a blank black slide (Note: it’s recommended that this be done in a completely 
separate browser window from one you may already have open) 

2. In OBS, create a Window Capture source and select the Google Slides window 
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3. Position the Google Slides Window Capture at the bottom of the Sources dock 

4. Reposition your Panel Discussion sources so that there is a rectangular opening at the bottom of your 
Preview/Program window 

5. In Google Slides, click Slideshow 
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6. Open the three-dot menu in the lower left corner. Select Caption Preferences > Toggle Captions. You can 
also adjust the size of the captions if desired. 

7. Select ‘Exit Full Screen’ 

8. Start speaking to test if the captions are working 
9. Open OBS – you should be able to see the captions appearing within the Preview/Program window (adjust 

size/location if necessary) 
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One limitation of this technique is that it will only pick up your voice and not others in a remote location. To 
get around this, you can use an external speaker for your computer instead of headphones, so the Google Slides 
captioning will also pick up their voices. 
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11. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=104#oembed-1 

In the following section, you will need to download the following plugins: 
VB-Audio Cables are used in a similar manner to virtual cameras. It is software that assists your computer in 

redirecting the audio to the desired input and output. 

By going into the OBS Settings Audio tab, you can add these virtual cables to your Global Audio Devices 

Audio Monitor 0.7.1 – Plugin for OBS Studio to add Audio Monitor dock and filter. It allows you to put the audio 
of a OBS source to an audio device by adding the Audio Monitor filter on the Source in OBS Studio. 

To add a Media Source to your Scene: 

1. Click the “+” at the bottom of the Sources dock 
2. Select Media Source from the Sources menu 
3. Give a name to this Source
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4. Click Browse and select the Media source you would like to add to your Scene. For ease of use, add the 
recording we just created in the screen capture and recording 

5. Also, select Loop and reduce the speed of the video 

Playing Media Audio with the Virtual Camera 

Within the Audio Mixer dock: 
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Click on the gear at the far right under the “Media Source” (the name of this audio source will be the name of 
the you gave to the media source) 

In the Audio Source menu, select “Advanced Audio Properties” 

Within the Advanced Audio Properties window, under the “Audio and Monitoring” settings, change it from 
“Monitor Off” to “Monitor and Output” 

This will allow for the audio from your Media Source to play through your Virtual Camera. 

Using VB-Audio Cables & Audio Monitor Plugin 

In order to use OBS for your audio in Zoom, you will need to follow these steps and install the Audio Monitor 
plugin. This will direct that audio into the location you want. 

In order for this to work, you will need to set your zoom microphone to be a VB-Audio Cable: 
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Then follow these steps in OBS Studio: 

Click on the gear at the far right under the “Media Source” (the name of this audio source will be the name of 
the you gave to the media source) 

In the Audio Source menu, select “Filters” 

 

If you have not installed the Audio Monitoring Plugin you will not see the Audio Monitor filter: 
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You can choose to just share your microphone and/or also share your desktop 

Also, if you are sharing media through OBS Studio, Media Sources also have an Audio/Video Filter and you would 
want to direct that audio to the VB-Audio Cable you selected. 
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Audio Filters 

Audio Filters are important for improving how you sound and removing background noise. Here is how you add 
these filters: 

 

Click on the gear at the far right under the “Media Source” (the name of this audio source will be the name of 
the you gave to the media source) 

In the Audio Source menu, select “Filters” 
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Noise Suppress: Remove background noise 

Suppress Level (dB) – lower dB Value=more suppression 

Start on -10 and go down up to -60 until the background noise is gone 

Gain: Increases the Input 

Gain (dB) – negative Values will lower your Audio Input while positive Values will increase it 

Do some tests by recording your Audio Input and checking the video to make sure no clipping occurs because 
of too audio high volumes. 

Noise Gate: Turns the Microphone off if no one is talking 

Close Threshold – When the mic drops below this volume, the noise gate will turn off the microphone 

Open Threshold – When the mic goes above this volume, the noise gate will turn on the microphone 

Attack time – How long it takes for the mic to go from off to on, as a fade in. 
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Hold time – How long the mic should stay on after the volume has dropped below the close threshold. 

Release time – How long it takes for the mic to go from on to off, as a fade out. 

In most cases configure your Close Threshold first (it always has to be lower as your open Threshold). First 
do not talk and see if the Microphone inputs any Volume in OBS, then increase the Close Threshold until the 
Microphone input stops. 

Now start talking and see if your Open Threshold is correct. You should see the green bar moving, meaning your 
voice comes in. You can then increase the Open Threshold until the Microphone stops showing input in OBS. 
Then slightly lower it again and you should have a good value. 

Compressor: makes loud sounds quieter and typically would be placed at or near the beginning of your filter 
chain. 

 Ratio – The amount of compression or gain reduction to apply to a signal that is above the threshold. For 
example, 2:1 will be a weak compression (this translates to an audio level 6dB above the threshold will be 3dB 
above after the compression), while 6:1 will be a much stronger compression. 

Threshold – Once the signal reaches this level the compressor will begin to apply compression at the set ratio. 
When levels are below the threshold the ratio is 1:1 which translates to no gain reduction. 

Attack – How quickly, in milliseconds, you want the compressor to reach full gain reduction when levels exceed 
the threshold. 

Release – How quickly, in milliseconds, you want the compressor to return to zero gain reduction after levels 
drop below the threshold. 

Output Gain – When you compress a signal it typically ends up quieter which reduces your average level. 
Applying Output gain brings the average level of the source back up which can help improve its presence over-
top of other audio sources. 

Sidechain/Ducking Source – When a compressor is placed on an output audio source such as your Desktop, 
Sidechain can use the input from a microphone/aux source to reduce the volume of the output source. See 
Sidechain Compression/Ducking. 
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* If you do not like this 
image and would like 
to use a different 
image, you can use 
any green screen gif 
for this exercise 

12. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=122#oembed-1 

Using a Green Screen Image 
1. Create a new Scene and call it “Green Screen Exercise” 
2. Save a copy of this image to your computer 

3. Next, save a copy of this gif to your computer 

Green screen Furret Pokemon gif 

4. In OBS Studio, Click the “+” at the bottom of the Sources dock 
5. Select Image 
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6. Name this Source “Panel Layout”, add the image, then make it fit your Preview window 

7. Click the “+” at the bottom of the Sources dock 
8. Select Image 
9. Name this Source “Green Screen”, and add the Green Screen gif you just saved 
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10. Make sure that your “Green Screen Gif” Image Source is above the “Panel Layout” Image Source 

11. Next, right click on the “Green Screen Gif” Image Source and select Filters 
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12. Within the Filters window click on the + to add a new filter. Select the Chroma Key filter

Sometimes this window appears very large in your screen and the “+” for Effect Filters may be below the 
viewable area on your display. The default setting for this filter is set to removing green. This is why you notice 
immediately the green surrounding the ferret has been removed. If you select the drop down menu you will 
notice there are other preset colors, as well as a custom color setting. 

Feel free to play with the other setting in this filter to see how they affect your Image Source. 
13. If you want to reset the Filter settings after playing with them click the “Defaults” button 

14. When satisfied with the results, click ‘Close’ 
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Using Green Screen Video 
1. Save this green screen image to your computer 

2. Create a Zoom room and click the Video carrot, then select Change Virtual Background 

3. Click the + button and select Add Image, then upload the green screen background you just saved 
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4. Make the green screen your background; it’s recommended to follow the remaining steps with Zoom 
minimized 

5. in OBS, create a new Window Capture source and select your minimized Zoom window 
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6. If nothing appears, try changing the capture method to something other than automatic (Windows 10 
appears to work well) 

7. Select the Zoom window in OBS and click Filters 

8. Add a Chroma Key Filter 
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You should now be visible in OBS but have your background removed, all without using a physical green 
screen backdrop. 

However, in addition to the imperfect quality of the chroma key effect, one limitation of this technique is that, 
because Zoom is being fed into OBS, you’ll be unable to use OBS’ virtual camera to feed the resulting effect back 
into Zoom. So, this technique is most applicable when recording locally or running a live stream on platforms 
like Twitch or YouTube. 
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This exercise was directed at displaying how you can remove green screen backgrounds. If you are creating 
tutorials and would like to appear like a weather person in front of a screen or PowerPoint, these are some 
methods to accomplish that. 
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13. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=141#oembed-1 

When you start OBS Studio for the very first time the program will initiate by having you setup your first OBS 
Studio Profile. If you have already setup your first profile. you can create new profiles through the Profile menu 
by selecting ‘New’ from the dropdown. 

When you are creating your profile you will be asked to add a name for your new profile. 

Next you will be asked about the intended use of this profile. It might be best if you create three profiles 
optimized for each purpose: Streaming, Recording, and using your Virtual Camera. 
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Next, you will set up your video settings. OBS Studio will know the resolution you were using and the default 
Frames Per Second(FPS) are already optimized for the type of usage you selected in the previous window. 
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Video Settings for Live 
Streaming 

Within the next window, you will find Stream Information. You can select the Service you will be streaming from. 
In this tutorial we have selected YouTube. Then select Connect Account to authenticate your YouTube account 
with OBS Studio. 
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When you have selected Connect Account a YouTube User Authorization window pops up. 
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Then, within your browser a Google page will open asking you to connect your account with the OBS Studio 
service. Select the account you would like to connect. 
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On the next screen click ‘Continue’ 
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The next web page will indicate the authorization was completed successfully and you can close the page. 
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Next, in OBS the Auto-Configuration Wizard will test your connection with the YouTube Server. You might 
also notice that your Program window in OBS Studio has a static screen during this testing – don’t worry, that is 
normal. 

If there are any issues at this point, the process will fail. This could be for several reasons, such as a weak 
internet connection, or your YouTube channel not yet being authenticated and setup for Live Streaming. 

Note that this is a separate authentication process required by and done directly through YouTube, and can 
unfortunately take up to 24 hours to complete. To find more information on how to authenticate your YouTube 
account, visit this link. 

Upon completion of a successful connection, you should move on to the next Auto-Configuration Window. 
This window will indicate the final results of the test and that it was completed successfully. Click the ‘Apply 
Settings’ button to complete the setup of your YouTube Live Stream Profile. 
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Once you have completed your profile setup, you will notice a new button on your Controls dock called 
“Manage Broadcast”. 

If you click on “Manage Broadcast” you will get a window that allows you to adjust the settings of your 
broadcast. 

1. Create a Title and description 
2. Adjust privacy settings (important to select Private if you are just testing) 
3. Select a category that YouTube will place the feed under 
4. Select “No, it is not made for kids” unless it is directly made for children audiences 
5. Add a thumbnail of an image you would like to use to represent your Live Stream in search results 
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If you select the second tab on the top of the window, you can review your previous broadcasts. This page also 
allows you to “Open YouTube Studio” with the button at the bottom. This is very handy as clicking on it provides 
quick access to your Live Streaming Studio on YouTube. 
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When you are in YouTube Studio and you have selected to “Start Streaming”, you will be provided with a page 
that provides you with great information about your stream, including live analytics and a chat moderation 
window. 
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If you do not access the YouTube Studio through the “Manage Broadcast” settings, you can access the studio 
through YouTube by selecting the “CREATE” button next to your profile icon, and the clicking on “Go Live” 

 

      
It is best to always test out your stream functionality prior to doing a live event. Audio can be very tricky if you 

are using multiple sources. Have fun, and happy streaming! 
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14. 

OBS Reference Material 

1. OBS Studio Quick Start Guide 
2. OBS_Reference_Manual 
3. OBS Forum Resources 
4. Reddit OBS Community 
5. YouTube #OBS tagged videos 

Media Libraries 

1. Internet Archive Creative Commons Media 
2. New York Public Library Public Domain Moving Images 
3. Flickr: The Commons 
4. UTM LibGuide: Images and Visual Resource Collections 
5. Wikimedia Commons 
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15. 

OBS Studio Terminology 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=146 

 
Learning OBS Studio Sources 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=146 

 
OBS Studio Scene & Source Filters 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=146 
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PART II 

AUDACITY 

In this section on Audacity, you will learn how to use the software to create dynamic interviews, podcasts, and 
general audio editing techniques. We will go over importing audio files, editing, recording, and playing back 
audio, then packaging and exporting the project. 

Audacity is an easy to use, free, and open-source multi-track audio editor and recorder. It is available to use on 
Windows, macOS, and Linux operating systems. While this training will focus on the Windows interface, many 
of the actions and skills found within this training will be similar across each operating system. 

Download and install the latest version of Audacity. 
You will need the following two files to build this short podcast in each of the exercises. 

1. Sample Interview Audio 
2. Sample Music Audio 

Please note, this guide was written using Audacity Version 3.1.3 Due to the open source nature of Audacity 
and the updates made to the software over time, the version you work with may differ slightly from what is 
presented here. 
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16. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=150 
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17. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=158#oembed-1 

FFmpeg Library Issue 
The optional FFmpeg library allows Audacity to import and export a much larger range of audio formats 

including M4A (AAC), AC3, AMR (narrow band) and WMA and also to import audio from most video files. 
Because of software patents, Audacity cannot include the FFmpeg software or distribute it from its own 
websites. Instead, use the following instructions to download and install the free and recommended FFmpeg 
third-party library. It is recommended that you exit Audacity before installing FFmpeg. 

To install the FFmpeg Library 

1. Use the following links to download the FFmpeg Library and install it: 

1. Windows install instructions  : use the FFmpeg v2.2.2 INSTALLER (.EXE) 
2. Mac install instructions : use thelame_64bit_osx.pkg 
3. Linux install instructions 

2. After you have installed the FFmpeg Library, close Audacity if you have it open and relaunch the 
application 

3. Select ‘Edit’ from the main menu 
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4. Then click on ‘Preferences’
5. In the Preferences window select ‘Libraries’ in the menu on the left
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6. Click the “Locate” button

7. Audacity should automatically locate the FFmpeg libraries. You can select ‘No’, to not locate them 
manually and continue using the application with a larger array of file types. 

Once the FFmpeg Library has been installed, you can import video files and strip the audio from them. This can 
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VLC Player Media 
Menu 

be very useful for editing videos in the future, because Audacity is has much better tools for audio editing than 
most video editors. 

Alternative: File conversion & import audio 
If you are having issues with this install, you can also download VLC Player and convert formats that are not 

natively able to be converted into Audacity. 
To convert files using VLC, you do not even have to open them. 

After opening VLC Player: 

1. Select: Media-> Convert / Save 
2. Or press Ctrl+R 

FFmpeg Library  |  75

https://www.videolan.org/vlc/index.html


Open Media Window, 
VLC Player 

In the Open Media window: 

1. Click: “+Add” button and select your file 
2. Click: Convert / Save 
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Convert Media 
Window, VLC Player 

In the “Convert” window the default setting will be 
MP3, this file type can be imported into Audacity 

1. Click: “Browse” to select the folder you would like to save the file 
2. Remember to rename the file. VLC might save it with the same name and file extension otherwise and 

corrupt the file. 
3. Click: “Start” 

You can also use iTunes to convert audio files, if that is easier. Instructions for using iTunes to convert audio files. 
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18. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=162#oembed-1 

We are going to import the audacity-intro.mp3 into Audacity. There are multiple methods of importing audio 
files into Audacity: 

 

1. Select: File -> Import -> Audio 
2. Or press Ctrl+Shift+i 
3. Or you can drag and drop the file on the Audacity Project Window 

Some files you have recorded may not be importable. Use VLC player to convert those files to MP3, as shown in 
the previous section, or install the FFmpeg Library. After you have imported audio files into Audacity it should 
look like this. You can clearly see your audio file in stereo waveforms. 
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If your interface doesn’t look exactly like this, that might be because of the fluid design shifts the toolbars 
around. 

The Transport Toolbar functions from left to right: Grabber (used to move the toolbar to a custom location), 
Pause, Stop, Skip to Start, Skip to End, Record, Loop Click the green Play button on the Transport Toolbar to 
listen to the track we have imported. 
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19. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=164#oembed-1 

A new track can also be created by selecting ‘Add New‘ > ‘Stereo Track’ from the ‘Tracks’ menu. 

Within the ‘Add New’ menu, you will notice there are a few other track types to choose from. 

1. Mono Track: rarely used because most audio is produced in stereo 
2. Stereo Track: this is the default track used in Audacity 
3. Label Track: allows you to annotate selected areas of your project. This can be important when editing long 

interviews, conversations, or music. 
4. Time Track: allow you to progressively increase or decrease the playback speed of all tracks in your project 
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Device Toolbar, 
functions from left to 
right, Grabber, Audio 
Host, Recording 
Device, Recording 
Channels, Playback 
Device, Resizer. 

20. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=170#oembed-1 

If there is extra audio that you need to record or add to audacity-intro.mp3. Recording new audio in Audacity is 
really simple. 

Before recording make sure you have selected your best audio recording microphone in the Device Toolbar’s 
Recording Device drop down menu. 

You can check to see that your microphone is picking up audio by checking the Record Meter. 
Recording Meter Toolbar inactive, default size 

If you click on the microphone button, and select ‘Start Monitoring’ you will be able to see your microphone is 
picking up sound if it is working properly. 

When your microphone is setup and working properly. You can begin recording. To record audio simply press 
the ‘R’ key on your keyboard or use the Record button on the Transport Toolbar 

To stop the recording press the ‘P’ key on your keyboard to Pause the recording, or the ‘X’ key to Stop the 
recording. You can also use the Transport Toolbar to Pause or Stop the recording as well. If you paused your 
recording, you will need to Stop the recording to exit recording mode. 

Add some audio to the end of the audacity-intro.mp3 track. If you tried this, you will notice it started the 
recording immediately following the end of the audacity-intro.mp3 
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If you would like to record on a new track, you can press ‘Shift +R’ on your keyboard and you will start recording 
on a new track from where ever the playhead is located on your timeline. 

 
Noise Reduction 
You can also remove background noise by using the ‘Noise Reduction’ effect. You can find the ‘Noise 

Reduction’ effect in the ‘Effects‘ menu. You will also notice there are a lot of effects you can use. Noise Reduction 
can reduce constant background sounds such as hum, whistle, whine, buzz, and “hiss”, such as tape hiss, or fan 
noise while you are recording. It is not suitable for individual clicks and pops, or irregular background noise such 
as from traffic or an audience. 
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After you have selected the ‘Noise Reduction’ effect. The Noise Reduction window will pop up. Click ‘Get Noise 
Profile’, this will help Audacity to know what sounds to filter out. 

Click ‘OK’, select the audio clip you would like to adjust background noise on and access the Noise Reduction 
window one more time and just click the ‘OK’ button again. Audacity will use the noise profile it obtained 
previously to adjust the background noise. 
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Tools Toolbar, features 
from left to right: 
Grabber, Selection, 
Envelope, Draw, 
Zoom, Multi Tool 

Edit Toolbar, features 
from left to right: 
Grabber, Cut, Copy, 
Paste, Trim, Silence, 
Undo, Redo, Zoom In, 
Zoom Out, Fit Section, 
Fit Project, Zoom 
Toggle 

21. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=180#oembed-1 

Now that there are a couple audio clips in our project. It would probably be a good idea to understand how to 
edit these clips. In this section we will go over a few of the most common editing features used in Audacity. 
Many of these features can be accessed using the Tools Toolbar or the Edit Toolbar. 

 

Tools Toolbar, features from left to right: Grabber, Selection, 
Envelope, Draw, Zoom, Multi Tool 

 

 
Cut & Paste 
In Audacity, the most common editing you will do is cutting, pasting, and trimming. To cut, you would use the 

selection tool to select the area you would like to remove. Select an area in the middle of an audio clip. Click the 
scissors icon or press “Ctrl +X”. You will notice the selected area is removed and the audio found on either side 
of the selected area have been moved together. 
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This is probably not the result you were expecting. The selected audio is now stored on your virtual clipboard. 
Select a separate area on the track and click the ‘Paste’ button on the Edit Toolbar. The previously cut selection 
is now back. 

When working with large audio clips using the ‘Cut’ tool to make many smaller clips might make the editing 
process easier. 

History 
To restore the previously cut and pasted audio, we can select the ‘Undo’ button on the Edit Toolbar. Likewise, 

if you undid too many previous tasks and you would like to restore something, there is a ‘Redo’ button on the 
Edit Toolbar as well. 

Also, if you would like to revert much further back in your project Audacity saves the history of your project 
and you can access the history under the View menu then click the ‘History’ menu item. 

Trim 
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The ‘Trim’ tool works in the opposite way of the ‘Cut’ tool, and can also be found on the Edit Toolbar. Using 
‘Trim’ you will be left with the selected area, and the unselected parts of the clip will be removed. 

Be careful when using this tool on large audio clips, you might remove more than you intended. 
Silence 
Silence does exactly what it sounds like it would do, it silences audio. You can use this as an alternative 

to cutting parts of your clip, if you would like. It is also a good way of reducing unwanted background noise 
between dialogue clips. 

Time Shift or Moving Audio Clips 
There used to be a tool in the Tools Toolbar called ‘Time Shift’. Essentially, this was the tool you would use to 
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move around audio clips, since you can have several clips per track or project. However, with the latest release 
of Audacity, this function can be completed when you hover over the top of a clip where the clip title is and the 
hand cursor becomes available, you can then move clips around even onto a different track. 

Zoom 
If you are having trouble cutting, trimming, or silencing a portion of an audio clip, use the Zoom In and Zoom 

Out buttons on the Edit Toolbar to get a more precise selection of the area on the audio clip you would like to 
edit. 

When Zooming really far in, remember to use the scroll bar at the bottom to navigate around your track 
Scrubbing 
The primary method for scrubbing is with the Scrubbing command from the Transport Tooolbar: Transport > 

Scrubbing > Scrub 

You can also selecting a section on the Timeline to Scrub and click the ‘Play’ button. This will replay this 
portion of your project in a loop. A great tool if you are trying to figure out what in that section of your project is 
just not right. 
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Envelope 
The Envelope Tool can be used to emphasis parts of your track or quiet them down. 
An amplitude envelope is manipulated by a number of control points. Each control point is visible by its four 

handles (the small circles in the image below), by which you can drag the point up or down to control the 
volume level. 

Dragging either the top or bottom handle ensures you can never distort the track by dragging outside its 
original volume envelope. 
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22. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=183#oembed-1 

When layering tracks, you will want to make sure you take advantage of the Track Control Panel. It give you 
the ability to control the gain of each track and ensure your narrative tracks are louder than your instrumental 
tracks. You can also use the left and right pan slider to create an atmosphere of a conversation by having 
different participants set to left, right, or center. 

 
Using the envelope tool can also be assistive in increasing the volume of instrumental tracks during breaks 

or transitions. You can also do this by having a separate track for break/transitional instrumental tracks that is 
set to a separate gain. You can use as many tracks as you believe is necessary to get the effects you want or the 
organization that makes sense to you. 
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23. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=189#oembed-1 

Saving the Project 
To save a project you are still working on, it is recommended to: File -> Save Project -> Save Project or “Ctrl +S” 

You might get this warning. But, as you can tell, it states this is not the file you would play for others. 

Exporting an Audio File 
To save an audio file to distribute or share, it is recommended to: File -> Export -> Export as MP3 
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You might get this warning. This means it is reducing your project into one track. This is okay. It needs to be 
in this format to distribute, and we already saved the project, if it needs to be edited again. 
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24. 

Audacity Reference Material 

1. The Audacity Manual 
2. Introduction to Podcasting, UTSC Library Libguide 
3. Audio Podcast How-to, by UTSC 

◦ How to Create an Audacity Project File 
◦ How to extract a clip from interview recording 
◦ How to record a clip of your voice 
◦ How to export the Audacity Project to a single audio file 
◦ How to extract time codes from sound file 

4. UVic Libraries Digital Scholarship Commons 

◦ Podcast Recording with Audacity 
◦ Podcast Editing with Audacity 
◦ Audio Transitions, Voiceovers + Royalty Free Music in Audacity 

5. Reddit Audacity Community 
6. YouTube #audacity tagged videos 

Media Libraries 

1. Internet Archive Creative Commons Media 
2. New York Public Library Public Domain Sound Recording 
3. Flickr: The Commons 
4. UTM LibGuide: Images and Visual Resource Collections 
5. Wikimedia Commons 
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25. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=193 
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PART III 

OPENSHOT 

OpenShot is a free video editing software you can use to create any number of videos, from instructional 
lectures/workshops to short films. Using OpenShot in combination with video or audio recordings from OBS or 
Audacity is a great way to create polished final videos. In this guide, you’ll learn the ins and outs of OpenShot – 
from basics like Video Playback to using Keyframes to animate objects. 

Each section’s content is given from the perspective of editing an educational video, which is intended 
to support educators looking to use videos in their practice. However, the techniques and tips provided can 
be applied to any project you take on. As a culmination of the knowledge in each section, one final section 
dedicated to learning how to piece together an animated instructional video is provided. 

Chapter Objectives 

• Become familiar with navigating OpenShot 
• Support educators in enhancing (a)synchronous learning content 
• Provide tools and knowledge that can be used for any kind of video editing 

Learning Outcomes 

• Basic editing techniques such as importing content and trimming footage 
• Intermediate editing techniques such as adjusting audio and using effects 
• Advanced editing techniques such as modifying properties and using keyframes 

Resources 
To install OpenShot, download it from the website and follow the installation prompts. Please note that this 

guide was written using OpenShot Version 2.6.1. Due to the open source nature of OpenShot and the updates 
made to the software over time, the version you work with may differ slightly from what is presented here. 

User Guide 
Help Forums 
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26. 

Review the OpenShot User Guide if you are having trouble with the following activity. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=196 
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27. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=201#oembed-1 

Before you can start editing your video, you’ll need to import your files into OpenShot. When files are imported, 
they reside in the Project Files area. 

To import your files, click the Import Files button (green +) on the main Toolbar. Note that you can import files 
multiple ways. You can also: 

1. Use the keyboard shortcut CTRL/CMD+F 
2. Drag & drop files into the Project Files area 
3. Right click in an open area in the Project Files area and select Import Files 

Once your files are imported, you’ll need to move them down to the Timeline to begin viewing and editing 
them. To do this, simply click and drag your files down to the Timeline. 
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28. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=206#oembed-1 

To review the footage you’ve imported, use the navigation buttons beneath the Preview Window to control 
playback. Each button can also be controlled with a keyboard shortcut (see below). This can make it easier to 
review footage, as one hand can control playback while the other uses the mouse. 

Adjusting the Playhead 

You can also identify and alter where playback occurs by adjusting the blue Playhead on the Timeline. To 
reposition the Playhead, click and drag left or right. Alternatively, double-click anywhere along the ruler to call 
the Playhead to that spot. 

 
Video Preview Window Keyboard Shortcuts 
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29. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=214#oembed-1 

By using the Playhead (green triangle) and navigation buttons (orange arrows), carefully watch through your 
video footage. Doing this before making any additions or changes to your video will make the editing process 
smoother. If you were to make changes before trimming your footage, there is a good chance the changes may 
be affected by or completely removed when trimming footage. 

To comb through and trim footage: 

1. Press the Play button (or spacebar) to start the video 
2. Pause the video when you see something you want to trim 
3. Click the Marker button to note where along the Timeline you want to make cuts 
4. Using one of methods below, trim your footage 

Trimming Methods 
Method 1 – Razor 

1. Select the Razor Tool and left click in line with the Markers you placed 
2. Deselect the Razor tool once finished making the cuts 
3. Left click on the unwanted footage and press the delete or backspace key to remove 

 
Method 2 – Slice 
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1. Use the Previous/Next Key Point buttons to position your Playhead on the markers you placed 
2. Right click on the file and select Slice 
3. Select either Keep Both Sides or Keep Left/Right Side 

Repeat this process for the entire video until you’ve reached a point where you are satisfied with the content, 
length, and ‘rhythm’ of the video. Now that all these changes have been made, making other changes will be 
easier. 
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30. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=220#oembed-1 

Track Layers 

It’s important to understand that OpenShot works in a layered fashion, meaning that any asset that is placed 
‘above’ another in the Timeline will also appear on top of the other footage during playback. For example, any 
asset placed on Track 1 will appear beneath Track 2, and anything on Track 2 will appear beneath Track 3. 

Adding a Lower Third 
Adding a Lower Third can be an effective way to add visual interest and an air of professionalism to your 

instructional video. To do so: 

1. Locate the Title drop-down menu, select Title 
2. Browse the templates to find a style you like 
( Note: some Title templates are intended to be used as Title screens, and some are intended as Lower Thirds. 
For the latter, one of the ‘Gray Box’ options is recommended) 
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3. Customize what text will appear in the Lower Third by editing the Line boxes 
4. If desired, modify the font style and text/background color 
5. Drag the Lower Third from your Project Files down to the Timeline (remember to place above your video) 
6. To adjust how long the Lower Third appears for, click and drag the right side 
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31. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=230#oembed-1 

Using OpenShot’s built-in Transitions can help pace your video by transitioning between ideas or scenes, 
informing viewers that something different is coming. OpenShot’s built-in Effects have both visual and auditory 
modifiers. Using them can help increase a viewer’s engagement by providing visual or auditory stimuli. 

Used effectively, Transitions and Effects are more than simple eye candy, and rather can be used to 
demonstrate an idea or emphasize/draw attention to something. 

To add transitions: 

1. Navigate to the Transitions tab 
2. Locate the transition you’d like to add 
3. Click and drag the transition down onto your clip 
4. Adjust the length of the transition by dragging on either the left or right side 

5. To delete a transition, left click on it and press the delete or backspace key on your keyboard 

To add effects: 
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1. Navigate to the Effects tab 
2. Locate the effect you’d like to add 
3. Drag the effect onto your clip in the Timeline 

4. To adjust the effect’s values, click on the letter symbol. This opens the Properties menu, in which you can 
alter various properties of the effect. 

5. To delete an effect, left click on it and press the delete or backspace key on your keyboard 
Note: The Remove Effect function can be very helpful if you make changes to the effect you can’t seem to set 
back to its default values 
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32. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=234#oembed-1 

Audio is just as important to a well-made video as the visuals. Most viewers may watch a video even if the visuals 
are not great, but not if the audio isn’t. Therefore, using OpenShot’s audio editing functions is an important step 
in creating your video. There are two main audio editing functionalities in OpenShot. 

 
Adjusting Volume 
To adjust an asset’s volume: 

1. Right click on the asset 
2. Select Volume > Entire Clip 
3. Select an appropriate level (0% = completely silent) 
Note: the ‘Reset Volume’ button is helpful for situations in which you would like to reset the volume back to its 
starting point, but you have made further changes to your video unrelated to the audio, meaning you cannot 
use the Undo button. 
Separating Audio 

As the name implies, this allows you to separate audio from a video clip. This allows you to make alterations 
to the audio without affecting the video (eg. cutting with the razor and replacing a poorly-recorded line with a 
better re-recording). To do this: 
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1. Right click on a video asset 
2. Select Single Clip or Multiple Clips 
Note: Separating the audio with Single Clip means that both the left and right channels of audio will be 
contained in a single clip, whereas Multiple Clips will produce two separate audio clips, one for both the left 
and right channel. In most cases, Single Clip is recommended. 
After separating the audio from a video, it will not be possible to merge the two back together. Additionally, 
cutting and moving around the audio may mean that it becomes de-synced with the video. Keep these points 
in mind when separating your audio. 
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33. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=241#oembed-1 

One of OpenShot’s most powerful tools is the Transform function, which allows you to alter an asset’s scale, 
location, and rotation. By keeping in mind how OpenShot layers content to mimic their order in the Tracks on 
the Timeline, you can easily use the Transform tool to create a picture-in-picture (PiP) effect so that viewers can, 
for example, see a speaker and their lecture content at the same time. 

To transform assets: 
1. Place the content that you’d like to appear as the smaller PiP (eg. video of speaker) on a Track in the Timeline 
2. Place the content you’d like to take up the main portion of the screen (eg. lecture slides) on a Track beneath 

the PiP footage 
3. Right click the PiP footage and select Transform. 
4. After selecting Transform, the object will be highlighted in the Preview Window, indicating you can interact 

with it. To complete the PiP effect you, adjust Scale and Position so that your speaker is smaller than the lecture 
slides, and positioned elsewhere on-screen (like the lower left or right corner) 

 
Although this PiP effect only required adjusting Scale and Position, he other properties you can edit using the 

Transform function are also listed below: 

Position: Place your mouse in the middle of the asset. Once you see two arrows that cross each other, click and 
drag the asset around the screen 

Scale: Click and drag the square blue handles that appear on the edges and corners of the asset 
Tip: press and hold the CTRL/CMD key to maintain the asset’s aspect ratio when scaling up or down 
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Rotation: Position your mouse just outside of the asset. Once you see two circular arrows, click and drag to rotate 
the asset 

Axis of Rotation: If you’d like your asset to rotate around a point other than the centre, click and drag the Axis 
Point to a new location, then rotate 

Shear: Position your mouse along the side or top/bottom edge of your asset. Once you see two horizontal arrows 
pointing in opposite directions, click and drag to shear your asset 
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34. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=246#oembed-1 

Properties 

All of the Transform functions, and more, can also be altered through the Properties menu. The benefit of using 
the Properties menu over the Transform tool is that you have greater precision due to being able to input 
specific numerical values. 

To edit an asset’s appearance or behaviour, right click on it in the Timeline and select Properties. This will open 
the Properties menu, which contains all of that asset’s properties. 
The way that you alter an asset’s properties is the same regardless of which property is being changed – by 
either clicking and dragging left/right to slide the value down/up, or typing in a numerical value. 
Keyframes 

It’s important to note that whenever the value of an asset is changed by using the Transform tool or Properties 
menu, a Keyframe is created wherever on the asset the Playhead is placed. This is indicated both by a green 
vertical line that appears on the asset in the Timeline, and by the text box turning green in the Properties menu. 
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Note: if the Playhead is not positioned over the asset, the Keyframe will by default be applied to the beginning 
of the asset 

Keyframes act as start and end points, between which a value is changed over time. This is how you can 
animate objects to move around the screen, visibly change their size/rotation/transparency, and more. 
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35. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=252#oembed-1 

To make your video more engaging and dynamic, you can use Keyframes to animate your visuals. Though the 
following example will focus on using Keyframes to create movement (having an image slide in/out of frame), 
the same techniques can be applied to other properties of an asset as well. 
To animate an image to slide on-screen: 
1. Select the asset you want to animate, and position your Playhead at the beginning (using the orange 
Previous Key Point button makes this easier) 

2. Right click on the asset > Properties 
 

3. Adjust the X/Y location values so the asset is off-screen 
Note: values shown are for demonstrative purposes. You may need to use different values for your asset 

4. Reposition the Playhead at the point in time you would like the asset to be finished sliding into view 

5. Adjust the X/Y location values so the asset is on-screen, at its final destination 
Note: values shown are for demonstrative purposes. You may need to use different values for your asset 
If done correctly, the asset will slide from its original X/Y location to the new X/Y location. The amount of the 
time it takes to transition from one set of coordinates to the other depends on the amount of time placed 
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between each Keyframe (ie. how far apart the green lines are from each other). 
This same principle of creating start and end points can be applied to many different property values such as 
volume, scale, alpha channel, and rotation. This is why understanding and experimenting with Keyframes is so 
critical to using OpenShot to its full potential. 
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36. 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=256#oembed-1 

Exporting Videos 

Once you’re completely satisfied with your video and no further edits are needed, click the red circular Export 
button to export your video. 

Before exporting, you’ll be able to change the file name, export location, and video quality. 
 
Closing Thoughts 

Due to the open-ended nature of video editing and the many different tools OpenShot provides, some 
functions and techniques have not been covered in this guide. However, by applying the techniques you’ve 
learned thus far and experimenting on your own video projects, you’ll discover the limitless range of how to use 
OpenShot. When combined with other open source software like OBS and Audacity, OpenShot is a powerful 
way to synthesize your work into a culminating video. 

Additionally, OpenShot has their own program Guide listed under the Help menu, you can always ask for help 
or advice from the community on the OpenShot subreddit. Thanks for taking the time to learn about OpenShot, 
and good luck putting together your future projects! 
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37. 

OpenShot Reference Material 

1. OpenShot User Guide 
2. Reddit OpenShot Community 
3. YouTube #OpenShot tagged videos 

Media Libraries 

1. Internet Archive Creative Commons Media 
2. New York Public Library Public Domain Moving Images 
3. Flickr: The Commons 
4. UTM LibGuide: Images and Visual Resource Collections 
5. Wikimedia Commons 
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38. 

OpenShot Terminology 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=260 

 
OpenShot Clip Properties 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=260 

 
OpenShot Key Frames 

One or more interactive elements has been excluded from this version of the text. You can view them 

online here: https://opentextbooks.uregina.ca/osdigcomm/?p=260 
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PART IV 

PRODUCING COLLABORATIVELY 

In the previous sections of this book, lessons in three distinctly different software applications have been 
provided. OBS Studio, Audacity, and OpenShot all have advantages in various aspects of digital media 
production. However, when using these software applications together you can take advantage of their 
strengths to create robust video content. Within this section, the exercise will provide a strategic method of how 
to use these applications in an effective order of operations. 

Since this section is intended to display the full production cycle, storyboarding and media production 
planning and management will be the initial focus. Followed by lessons in each application from screen 
recording, audio recording, and video editing. By the end of this section, you will have a completed video if you 
follow every exercise. 
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Storyboard sketches 
do not need to be 
elaborate. They can 
be simple stick figure 
sketches or various 
clip art components 
that assist in 
conveying the 
appropriate idea of 
the scene 

This storyboard adds 
animation and 
movement directions 
to the storyboard to 
help communicate 
the flow of the scene. 

39. 

What is Storyboarding? 
A storyboard is a visual representation of a film sequence and breaks down the action into individual panels. It 

sketches out how a video sequence will unfold. A storyboard is similar to a trial-run for your finished film, video, 
or commercial, laid out in a comic book-like form. 

Why is Storyboarding Important? 

1. It helps you to visualize your script and identify scenes and camera angles 
2. It helps save time by being able to plan out everything you intend on doing 
3. Identifies the key components of your video and initiates the creative process 

Step 1:  Write a Script 
Draft it, review it, mark it up however you feel will be most beneficial, such as adding directives and actions 
Step 2: Make a shot list 
A shot list can easily be made by going back to the script and identifying the areas within the script that you 

envision new clips, frames, or scenes 
Scene 1 ________________ 
Scene 2 ________________ 
Scene 3 ________________ 

Step 3: Sketch it out 
Based on your script, you should now have a good idea of how many frames you will need. Start creating. 

Add shapes, arrows, pictures, graphics, gifs, and text to illustrate your intention for each scene. The purpose is to 
convey your idea, however you can best communicate the intension. 

Google slides can easily be used to create storyboards. 
You don’t have to be an amazing artist to storyboard – stick figures work just fine. 

Your storyboard is for your interpretation, use images that make sense to you. If your storyboard is to be used to 
share your vision, make a legend for your symbols you use or add descriptions to your symbols 
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Step 4: Add Your Context 
Remember to add your script to each slide, in the notes 
Add a line for actions, directives, purpose 
Example: 

Script: “Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et 
dolore” 
Directives: hold frame for 3 sec., zoom into top left, fade out to next scene 
Purpose (optional): This scene is to convey… 

Conclusion 
Concluding these steps, you will now have an initial draft of the video content you will be producing. This 

storyboard will assist in communicating with others and collaborating. It will be easier to understand the 
material the flow, layout, and intension of the video. Providing this prior to initiating media editing and creation 
can save a lot of time. It will greatly assist in ensuring the content of the video you are creating meets the 
expectations of all stakeholders. 
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Click the “Spreadsheet 
structure for editing 
together” image to 
view the spreadsheet 
and its content. 

40. 

When editing together, it is best to develop a structure for editing using time stamps. This can assist in directing 
the producer to the exact time that needs adjusting. 

Here is a sample table structure that can assist in working together to develop media content: 

Notice that the directions are descriptive. It also allows for “General Comments” and “Pause in sentences” 
seemed to be a common issue that they grouped together to make it easier to handle common issues all at 
once. 

While this is a method we have used in our media development practice, your team might come up with a 
solution that works for you. 
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